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Working with Office RT 
Graphics

When most people think about using the Office RT applications, 
they generally think about text, whether it is writing sentences and 
paragraphs in Word, adding formulas and labels in Excel, creating 
slide titles and bullets in PowerPoint, and so on. It is certainly true 
that most of the work people do in Office RT—from papers to 
purchase orders to presentations—is and should remain text based.

However, if you only think text when you think of Office, you’re 
missing out on a whole other dimension. All the Office RT 
applications have extensive graphics tools that you can take 
advantage of to improve the clarity of your work or just to add a bit 
of pizzazz to liven up an otherwise drab document.

Even better, these graphics tools work the same across applications, 
so once you learn how to use them, you can apply your knowledge 
to any program. This chapter shows you how to create, edit, and 
enhance graphics in the Office RT applications.

3
In this chapter, you’ll learn various techniques 
for drawing, inserting, and working with graphic 
objects, such as lines, photos, and clip art.

 B Drawing lines, rectangles, and circles

 B Inserting photos, clip art, SmartArt graphics, and 

WordArt images

 B Selecting one or more graphic objects

 B Sizing, moving, and rotating graphic objects

 B Applying styles and effects to graphic objects
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Chapter 3 Working with Office RT Graphics46

Working with Shapes
A shape is an object   such as a line or rectangle that you draw within your 
document. You can use shapes to point out key features in a document, 
enclose text, create flowcharts, and enhance the look of a document. In 
Office RT, you can use eight shape types:

 • Lines—Straight lines,  squiggles, free-form polygons, arrows, connectors, 
and curves

 • Basic Shapes—Rectangles , triangles, circles, boxes, cylinders, hearts, and 
many more

 • Block Arrows—Two-dimensional   arrows of various configurations

 • Equation Shapes—Two-dimensional  images for the basic arithmetic 
symbols, such as plus (+) and equals (=)

 • Flowchart—The standard shapes  used for creating flowcharts

 • Callouts—Boxes and lines for  creating callouts to document features

 • Stars and Banners—Stars,   starbursts, scrolls, and more

 • Action Buttons (PowerPoint only)—Buttons such as forward and 
backward that represent  standard slide show actions

Inserting a Line
You can use lines to point out     impor-
tant document information, create 
a free-form drawing, or as part of 
a more complex graphic, such as a 
company logo.

 1. Select the Insert tab. In OneNote, 
select the Draw tab, instead.

 2. Select Shapes and then select the 
shape you want from the Lines 
section.

Squiggle

Free-form

2

1
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47Working with Shapes

 3. On a touchscreen, position a 
finger or stylus where you want 
to begin the line. If you’re using 
a mouse, position the crosshair 
where you want to start drawing 
the line.

 4. Drag to where you want the line 
to end and then release. If you’re 
drawing a squiggle, drag in the 
shape of the line you want.

Taming Your Lines
If you have a keyboard, you 
can restrict straight lines and 
 arrows to horizontal, vertical, 
and 45-degree angles by holding 
down the Shift key while you drag 
the screen.

DRAWING A FREE-FORM POLYGON
The Lines section of the Shapes gallery includes a Free-Form icon that 
   enables you to draw a free-form polygon, which is really just a series of 
connected lines that create a closed shape. To draw a free-form polygon, 
follow steps 1 to 4 to create the first side of the shape. Then, using a stylus or 
mouse (this doesn’t work with a finger, unfortunately), tap where you want 
each subsequent side to end. When you’re done, double-tap the screen.

3 4
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Chapter 3 Working with Office RT Graphics48

Inserting Any Other 
Shape
You can    use the other shapes either 
on their own—for example, to point 
out features with callouts or block 
arrows or to enhance text with stars 
or banners—or as part of a more 
complex graphic.

 1. Select the Insert tab. In OneNote, 
select the Draw tab, instead.

 2. Select Shapes and then select the 
shape you want to insert.

 3. On a touchscreen, position your 
finger or stylus where you want 
to begin the shape. If you’re using 
a mouse, position the crosshair 
where you want to start drawing 
the shape.

 4. Drag until the shape has the size 
and form you want and then 
release.

Drawing Squares and 
Circles
If you have a      keyboard, you can 
make your rectangles square, your 
ellipses circular, and your angled 
lines 45 degrees, by holding down 
the Shift key while you drag the 
screen.

2

1

4

3
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49Inserting Images

Inserting Images
Although the shape tools   that come with the Office RT applications are 
handy for creating simple graphics effects, your document might require 
something more ambitious or specific. Office RT can help here, too, by 
offering several types of images that you can insert: 

 • Picture—You can  enhance the visual appeal and strengthen the 
message of a document by adding a picture to the file. The Office RT 
applications can work with the most popular picture formats, including 
BMP, JPEG, TIFF, PNG, and GIF. This means that you can insert almost any 
photo that you have stored on your computer.

 • Clip art—This refers  to small images or artwork that you can insert into 
your documents. Office RT doesn’t come with its own clip art, but it 
does give you access to the online Office.com clip art collection, which 
contains thousands of images from various categories, such as business, 
people, nature, and symbols. You can use any of these clip art images 
without charge.

 • SmartArt—You use  these graphics to help present information in a 
compact, visual format. A SmartArt graphic is a collection of nodes—
shapes with some text inside—that enables you to convey information 
visually. For example, you can use a SmartArt graphic to present a 
company organization chart, the progression of steps in a workflow, the 
parts that make up a whole, and much more.

 • Text box—The graphics  you add to your documents will usually consist 
of images, but times will occur when you need to augment those images 
with some text. For example, you might want to add a title and subtitle 
or insert a label. To add text to an existing image, you draw a text box 
and then type your text within that box. 

 • WordArt—You can add  some pizzazz to your documents by inserting a 
WordArt image, which is a graphic object that contains text stylized with 
shadows, outlines, reflections, and other predefined effects. WordArt 
images enable you to apply sophisticated and fun effects to text with 
just a few taps. However, some of the more elaborate WordArt effects can 
make text difficult to read, so make sure that whatever WordArt image 
you use does not detract from your document message.
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Chapter 3 Working with Office RT Graphics50

Inserting a Picture
If you have     a photo or other image 
on your computer that you think 
would add just the right touch, you 
can insert it into your document.

 1. Select the Insert tab.

 2. Select Pictures to open the Insert 
Picture dialog box.

 3. Open the folder that contains the 
picture you want to insert.

 4. Select the picture.

 5. Select Insert. The Office RT appli-
cation inserts the picture into the 
document.

LINKING TO THE PICTURE
You can set up a     link between the inserted picture and the original file, so 
that any changes you make to the original are automatically reflected in 
the document copy. Follow steps 1 to 4 to select the picture in the Insert 
Picture dialog box, then drop down the Insert menu.

If you want to keep your document size small, select Link to File to insert 
the picture as a link to the original file. Use this command when you want 
edits to the original file to be updated in your document but you don’t 
want a copy of the picture in the document. Note, however, that if you 
send the file to someone (say, via email or over a network), that person 
will not see the image unless he or she has the same image located in the 
same folder.

Alternatively, select Insert and Link to insert a copy of the picture into the 
document and maintain a link to the original file. Use this command when 
you want edits to the original file to be updated in your document but you 
also want a copy within the document just in case the original is deleted.

2

1
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51Inserting Images

Inserting Clip Art
Clip art is professional-quality art-
work that can     often add just the right 
touch to a newsletter, brochure, or 
presentation, and Office.com offers 
a huge selection of clip art images in 
dozens of different categories.

 1. Select the Insert tab.

 2. Select Online Pictures to open the 
Insert Pictures dialog box.

 3. Type a word that describes the 
type of clip art image you want to 
insert.

 4. Select Search. The application 
displays a list of clip art images 
that match your search term.

More Online Images
To search   for an image on the 
Web, use the Bing Image Search 
option to search for the picture. 
If you have connected your Flickr 
account to Windows RT, you 
can also use the Flickr option to 
choose a photo. If you are using a 
Microsoft account with Windows 
RT, you can use the SkyDrive 
option to select an image from 
your SkyDrive.

 5. Select the clip art image you want 
to use.

 6. Select Insert. The Office RT appli-
cation inserts the clip art into the 
document.

2

1

3 4
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Chapter 3 Working with Office RT Graphics52

CLIP ART DIRECT FROM THE SOURCE
If you’d like     an even easier way to locate the clip art image that you want, 
you can use a web browser to locate clip art images directly using the 
Office.com website. Navigate to http://office.microsoft.com/en-us/images/ 
and then select an image category, such as Business or People. Next, filter 
the images by media type and image size. For clip art, you should select 
Illustration in the Media Type list and All in the Image Size list.
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Understanding SmartArt Graphics
One of the most impressive of    the Office RT graphics features is support 
for the SmartArt format, which is based on the XML (Extensible Markup 
Language) standard. A SmartArt graphic is a collection of  nodes—shapes 
with some text inside—that enables you to convey information visually. You 
use SmartArt to illustrate concepts in seven main categories:

 • List—These are  concepts that are sequential or that form a progression 
or a group. Most of these SmartArt graphics consist of shapes arranged 
in vertical or horizontal lists.

 • Process—These are  concepts that progress from one stage to another, 
where the overall progress has a beginning and an end. In most of 
these SmartArt graphics, each stage is represented by a shape and 
accompanying text, and one-way arrows lead you from one shape to the 
next.

 • Cycle—These are concepts  that progress from one stage to another in 
a repeating pattern. In most of these SmartArt graphics, each stage is 
represented by a shape and accompanying text, and one-way arrows 
lead you from one shape to the next. The most common structure is a 
circle, with the last stage leading back to the first stage.

 • Hierarchy—These are  concepts that either show the relative importance 
of one thing over another, or show how one thing is contained within 
another. These SmartArt graphics look like organization charts.
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53Inserting Images

 • Relationship—These are  concepts that show how two or more items are 
connected to each other. In most of these SmartArt graphics, each item is 
represented by a shape and accompanying text, and all the shapes either 
reside within a larger structure, such as a pyramid, or are positioned 
relative to one another, such as in a Venn diagram.

 • Matrix—These are  concepts that show the relationship between the 
entirety of something and its components, organized as quadrants. 
These SmartArt graphics have one shape that represents the whole and 
four shapes that represent the component quadrants.

 • Pyramid—These are  concepts with components that are proportional 
to each other or interconnected in some way. In most of these SmartArt 
graphics, the component shapes are arranged in a triangle pattern.

Inserting a SmartArt 
Graphic
To build a     SmartArt graphic, you 
use the Text pane to add text to 
each node as well as add and delete 
nodes.

 1. Select the Insert tab.

 2. Select SmartArt to open the 
Choose a SmartArt Graphic dialog 
box.

 3. Select a SmartArt category.

 4. Select the SmartArt style you 
want to use.

 5. Select OK to add the SmartArt 
graphic to the document.

1

2

3
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Chapter 3 Working with Office RT Graphics54

 6. Select a node in the Text pane 
and then type the text that you 
want to appear in the node.

 7. Repeat step 6 to fill in the other 
nodes in the SmartArt graphic.

 8. To add a node to the SmartArt 
graphic, select the existing node 
you want the new node to come 
before or after.

 9. Select the Design tab.

 10. Select Add Shape and then select 
either Add Shape After or Add 
Shape Before.

Deleting Nodes
To remove   a node from the 
SmartArt graphic, tap and hold 
(or right-click) the node for a few 
seconds, then select Cut in the 
shortcut menu that appears.

Node text appears automatically 
in the associated shape.

Use the Format tab to 
customize specific shapes.

Select Text Pane to toggle the Text 
pane on and off.

6

7

Use the SmartArt Styles 
gallery to apply a style.

Use the Layouts gallery to 
choose a different layout.

10

8

9
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55Inserting Images

Inserting WordArt
WordArt takes     a word or phrase and 
converts it into a graphic object that 
applies artistic styles, colors, and 
shapes to the text. WordArt is there-
fore useful for newsletter titles, logos, 
and any time you want text to really 
stand out from its surroundings.

 1. Select the Insert tab.

 2. Select WordArt to open the 
WordArt gallery.

 3. Select the WordArt style you want 
to use. The Office RT application 
adds the WordArt image to the 
document.

 4. Type the text that you want to 
appear in the WordArt image.

 5. Tap outside the image to set it.

Use the Shape 
Styles gallery and 
commands to 
customize the image.

ADDING A TEXT BOX
The graphics you     add to your documents will usually consist of images, but 
sometimes you’ll need to augment those images with text. For example, you 
might want to add a title and subtitle or insert a label. If a WordArt image 
seems like overkill for this, then a better alternative is to draw a text box and 
then type your text within that box.

To add a text box, select Insert, Text Box, use a finger or stylus to drag until the 
text box has the size and form you want, and then type your text in the box.

Use the WordArt 
Styles gallery to 
apply a style.

1 2
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Chapter 3 Working with Office RT Graphics56

Formatting and Editing Graphic Objects
Inserting a line, shape, picture, or other graphic object is usually only half the 
battle. To complete your work with the graphic, you usually need to spend 
a bit of time formatting and editing the object to get it just right. This may 
include some or all of the following: sizing the graphic; rotating it; moving 
it; grouping or aligning it with other objects; and formatting the object’s 
fill, lines, and shadow effects. The rest of this chapter provides you with the 
details of these and other techniques for working with graphics objects.

Selecting Graphic Objects
Every graphic object has   an invisible rectangular frame. For a line or 
rectangle, the frame is the same as the object itself. For all other objects, the 
frame is a rectangle that completely encloses the shape or image. Before 
you can format or edit a graphic object, you must select it, which displays 
selection handles around the frame.

If you just want to work with a single object, then you can select it by tapping 
it. If you need to work with multiple objects, Office RT gives you a number 
of methods and the one you choose depends on the number of objects and 
their layout within the document:

 • The simplest scenario is when you have just a few objects to select. 
In this case, hold down the Ctrl key and tap each object. If you tap an 
object by accident, keep the Ctrl key held down and tap the object again 
to deselect it.

 • To select a few objects, you can “lasso” the objects, as described in the 
next section.

 • To select all the objects in a document, select one and then press Ctrl+A.
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Lassoing Graphic 
Objects
Lassoing graphic objects   begins 
using a finger or stylus to draw a 
rectangle around the objects you 
want to select. Use this technique 
when the objects you want are locat-
ed near each other.

 1. Select the Home tab.

 2. Tap Select.

 3. Tap Select Objects.

Lassoing Objects in Excel
To lasso objects in Excel,  select 
the Home tab, then Find & Select, 
then Select Objects.

 4. Place a finger or stylus at the 
upper-left corner of the area you 
want to select.

 5. Tap and drag to the lower-right 
corner of the area you want to 
select. As you drag, the program 
indicates the selected area with a 
dashed border.

 6. When the selection area com-
pletely encloses each object you 
want to select, release the screen. 
Excel places selection handles 
around each object in the selec-
tion area.

1

3 2

4

6

5
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Chapter 3 Working with Office RT Graphics58

Sizing a Graphic Object
If a graphic is too large    or too small 
for your needs, or if the object’s 
shape is not what you want, you can 
size the image to change its dimen-
sions or its shape. You might want to 
size a graphic so that it fits within an 
open document area. 

 1. Select the graphic you want to 
size.

 2. To adjust the width of the graphic, 
drag the left or right handle.

 3. To adjust the height of the 
graphic, drag the top or bottom 
handle.

 4. To adjust the width and height 
at the same time, drag a corner 
handle.

Sizing Multiple Sides
To size the  graphic on all four 
sides at once, hold down Ctrl 
while you drag any corner handle. 
Similarly, you can size the left 
and right sides simultaneously by 
holding down Ctrl while dragging 
a side handle; you can size the top 
and bottom sides simultaneously 
by holding down Ctrl while drag-
ging the top or bottom handle.

Sizing handles appear around the 
edges of a selected object.

2

4

1 3
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Moving a Graphic Object
To ensure that a   graphic is ideally 
placed within a document, you can 
move the graphic to a new location. 
For example, you might want to 
move a graphic so that it does not 
cover existing document text. 

 1. Select the graphic you want to 
move.

 2. Place a finger or the stylus in the 
middle of the object. Make sure 
you don’t place your finger or 
stylus over any of the object’s 
sizing handles.

 3. Drag the object to the position 
you want.

Horizontal or Vertical 
Moves
To move a graphic   object only 
horizontally or vertically, hold 
down the Shift key while drag-
ging it.

Rotating a Graphic 
Object
Most graphic   objects get inserted 
into a document without any rota-
tion: Horizontal borders appear hori-
zontal, and vertical borders appear 
vertical. A nonrotated image is 
probably what you will want most of 
the time, but for some occasions an 
image tilted at a jaunty angle is just 
the right touch for a document. Many 

1

3

2
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Chapter 3 Working with Office RT Graphics60

objects come with a rotation handle 
that you can use to rotate the object 
clockwise or counterclockwise. 

 1. Select the graphic you want to 
rotate.

 2. Use a finger or stylus to drag the 
rotation handle. Drag the handle 
clockwise to rotate the graphic 
clockwise; drag the handle 
counterclockwise to rotate the 
graphic counterclockwise.

Formatting a Graphic 
Object
You can enhance    your shapes, clip 
art, photos, WordArt images, and 
SmartArt graphics by formatting the 
images. For example, the Office RT 
applications offer more than two 
dozen picture styles, which are pre-
defined formats that apply various 
combinations of shadows, reflec-
tions, borders, and layouts. Office RT 
also offers a dozen picture effects, 
which are preset combinations of 
special effects, such as glows, soft 
edges, bevels, and 3-D rotations.

 1. Select the picture you want to 
format.

 2. Select the Format tab.

 3. Select More Picture Styles. The 
Picture Styles gallery appears.

Rotation handle

1

2

13 2
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Picture Style Preview
If you’re using a mouse, you can 
get a preview of   what the style’s 
effect will be on your graphic by 
hovering the mouse pointer over 
the style.

 4. Select the picture style you want 
to use. The application applies the 
Quick Style to the picture.

 5. Select Picture Effects. If the image 
is a shape, select Shape Effects, 
instead.

 6. Select Preset.

 7. Select the effect you want to 
apply. The application applies the 
effect to the picture.

4

76 5
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MORE EFFECTS
To gain maximum control over your graphic effects, select the object and 
then select Picture Effects (or Shape Effects). You can then use the six 
effect categories—Shadow, Reflection, Glow, Soft Edges, Bevel, and 3-D 
Rotation—to apply specific effects to the image.

>>
>G

o 
Fu

rth
er

REVERTING TO THE ORIGINAL
After playing     around with a graphic for a bit, you might end up with a bit of 
a mess. If you don’t like the formatting that you’ve applied to a graphic, you 
might prefer to return the picture to its original look and start over. If you 
haven’t performed any other tasks since applying the formatting, select Undo 
(or press Ctrl+Z) until the application has removed the formatting. Otherwise, 
select the Format tab, select Picture Effects (or Shape Effects), select Preset, 
and then select the icon in the No Presets section. To reverse all the changes 
you’ve made to a picture since you inserted the image, select the picture, 
select Format, and then select Reset Picture.

It’s Not All Good
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Symbols
3-D charts in Excel, 173-174

A
absolute cell references, 186

accepting changes
in Excel, 305-306
in Word, 299-300

accessing notebook properties in 
OneNote, 266

Accounting format in Excel, 160

action buttons, 46

activating Solver, 197

adding. See also inserting
borders in Excel, 166
bulleted lists to slides, 209-210
chart legends in Excel, 182
charts to slides, 212-213
chart titles in Excel, 180-181
columns/rows in Excel, 141
commands

to Quick Access Toolbar, 288-290
to Ribbon, 285-287

custom layouts to Slide Master, 223
data labels to charts in Excel, 183
Exit command, 7
notes to slides, 218-220
scenarios to Quick Access 

Toolbar, 195
slides, 206

tables to slides, 214
text to slides, 208-209
videos to slides, 211
words to dictionary in Word, 80

addresses, sharing with SkyDrive, 313

advancing slides automatically, 244

alignment of paragraphs, 40

analysis. See data analysis tools

animation in PowerPoint
bulleted lists, 232
guidelines, 226-227
slide object animation, 229-232
slide transitions, setting up, 227-228
sounds for transitions, 229

applications. See also names of specific 
applications (e.g. Word, Excel, Power-
Point)

documents, creating within, 9
graphics. See graphics
pinning

to Start screen, 5
to taskbar, 6

quitting, 6-7
starting, 4-5

applying
date and time formats in Excel, 162
indentation, 39
numeric formats in Excel, 162
styles, 41-42
tags in OneNote, 258
text colors, 33
type effects, 31-32
typeface, 29
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Index316 area charts in Excel

area charts in Excel, 172

arguments in Excel 
functions, 134

arithmetic formulas in 
Excel, 130

arrow keys, confirming data 
entry, 128

arrows, 46, 70

ascenders, 31

ascending sort in Excel, 143

attaching files in OneNote, 
272-273

AutoCorrect in Word, 67-70

automatic slide shows, 
244-245

AutoRecover, changing save 
interval, 13

B
background pattern, 

setting, 290

banners, 46

bar charts in Excel, 172

bar tabs, 72

basic shapes, 46

bibliography, inserting in 
Word, 111-113

blank documents, creating, 8-9

Blank layout, 205

blinds transition, 227

block arrows, 46

body fonts, 29

boilerplate, 67

bold type, applying, 31-32

borders, adding in Excel, 166

break-even point, computing, 
198-200

bubble charts in Excel, 173

building formulas in Excel, 
132-133

bulleted lists
adding to slides, 209-210
animating in 

PowerPoint, 232
creating, 35-36
list levels in PowerPoint, 209

C
callouts, 46

categories in Excel charts, 170

category axis in Excel charts, 
170, 180-181

cell addresses, entering in 
formulas, 132

cells
in Excel, 124

absolute cell 
references, 186

adding functions, 
134-137

avoiding overwriting, 153
converting to tables, 138
editing data, 129-130
entering data, 128
numbers, entering, 125
ranges, 147
selecting, 139
wrapping text within, 167

in OneNote, 255
in Word tables, 84

deleting, 90
merging, 89
selecting, 86

center tabs, 72

change history, changing 
length in Excel, 305

changes
accepting/rejecting

in Excel, 305-306
in Word, 299-300

filtering display of
in Excel, 304
in Word, 296-298

reviewing in Word, 298-299
tracking

in Excel, 303-305
in Word, 296

changing
AutoRecover save interval, 13
chart layout in Excel, 177
chart type in Excel, 174
length of change history in 

Excel, 305
onscreen keyboard 

layout, 67
page orientation in 

Word, 98
paper size in Word, 99
print settings, 20
reference marks in 

Word, 111
slide layout, 216
table styles in Word, 87
type size, 30
user name and initials, 

281-282

changing cells
in Goal Seek, 190
in Scenario Manager, 

192, 194
in Solver, 196-201

character formatting, 23

chart area in Excel, 170

charts in Excel, 169
adding to slides, 212-213
creating, 170-172
data labels, adding, 183
elements

formatting, 179
selecting, 178

layout, changing, 177
legends, adding, 182
moving, 175-176
resizing, 176
templates, creating, 175
terminology, 170
titles, adding, 180-181
types of, 172-174

chart sheets in Excel
creating, 171-172
moving charts to, 176

circles, drawing, 48

citations, inserting in Word, 
111-113

clearing
formatting, 43
narration, 236, 238
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317cycle category

clip art, 49
from Office.com, 52
inserting, 51

closing. See also quitting Office 
RT applications 

documents, 20
notebooks in OneNote, 265

collaboration
in Excel, 300-310

accepting/rejecting 
changes, 305-306

changing length of 
change history, 305

editing comments, 301
filtering display of 

changes, 304
handling sharing 

conflicts, 310
inserting comments, 301
restrictions on shared 

workbooks, 308
sharing workbooks, 

306-308
tracking changes, 

303-305
updating shared 

workbooks, 308
viewing comments, 

302-303
viewing/removing 

reviewers, 309
with SkyDrive, 310-313
in Word, 293-300

accepting/rejecting 
changes, 299-300

deleting comments, 295
editing comments, 295
filtering display of 

changes, 296-298
inserting comments, 294
reviewing changes, 

298-299
tracking changes, 296

collapsing outline levels in 
Word, 105

color-coding sections in 
OneNote, 250

colors of text, 33-34

column charts in Excel, 172

columns
defined in OneNote, 255
in Excel, 124

adding, 141
deleting, 142
resizing, 164
selecting, 139, 149

in Word tables, 84
deleting, 90
inserting, 88-89
selecting, 86

commands, adding
to Quick Access Toolbar, 

288-290
to Ribbon, 285-287

commas in Excel, 125

comments
accepting/rejecting in 

Word, 299-300
deleting in Word, 295
editing

in Excel, 301
in Word, 295

inserting
in Excel, 301
in Word, 294

reviewing in Word, 298-299
viewing in Excel, 302-303

comparison formulas in 
Excel, 131

Comparison layout, 205

concordance files in Word, 120

conflicts in sharing, handling in 
Excel, 310

constraint cells (in Solver), 
196-201

constraint operators 
(in Solver), 199

constraints, maximum number 
of, 200

containers in OneNote, 253-254

Content with Caption layout, 205

converting
cells to tables in Excel, 138
ink to digital text in 

OneNote, 276

text
to bulleted list, 35
to numbered list, 37
to table in Word, 85

copy, saving documents as, 
13-14

copying
formatting, 42-43
ranges in Excel, 152-153
slides, 207

Currency format in Excel, 159

custom bullets, creating, 36

custom footnotes/endnotes, 
creating in Word, 111

custom layouts, adding to 
Slide Master, 223

custom number formats in 
Excel, 162

custom numbers, creating for 
numbered lists, 38

custom slide shows, 238-241

custom table styles, creating in 
Excel, 140

custom tags, creating in 
OneNote, 259

custom text colors, creating, 34

customizing Office RT
adding commands

to Quick Access Toolbar, 
288-290

to Ribbon, 285-287
bypassing Start screen at 

launch, 282-283
changing user name and 

initials, 281-282
exporting Ribbon 

customizations, 287
hiding Ribbon, 284
moving Quick Access 

Toolbar, 288
opening Options dialog 

box, 280
pinning Ribbon, 283-284
setting background 

pattern, 290

cycle category (SmartArt), 52

9780789748690_index.indd   317 2/14/13   9:40 AM



Index318 data analysis tools

D
data analysis tools, 185

Goal Seek, 189-191
Scenario Manager, 192-195
Solver, 196-201
what-if analysis, 185-189

data (Excel)
editing in cells, 129-130
entering in cells, 128
formatting, 159-161
types of, 124
visualizing. See charts in 

Excel

data formats in Excel, 159-163

data labels, adding to charts in 
Excel, 183

data markers in Excel charts, 170

data series in Excel charts, 170

data tables in Excel, 186-189

data values in Excel charts, 170

date filters in Excel, 145

dates/times
applying formats in Excel, 

161-162
entering in Excel, 126-127
in Excel, 124
inserting in pages in 

OneNote, 267-268
updating automatically in 

Word, 93

decimal places, controlling 
number in Excel, 163

decimal tabs, 72

decorative typeface, 28

defining
outline levels for styles, 108
scenarios, 193-194

deleting
columns/rows in Excel, 142
comments in Word, 295
nodes, 54
ranges in Excel, 156
selected text, 26
slides, 218
table elements in Word, 90

demoting outline levels in 
Word, 107

descenders, 31

descending sort in Excel, 143

desktop, starting Office RT 
applications from, 5

dictionary, adding words in 
Word, 80

digital ink. See ink in OneNote

digital text. See text

direct formatting, 24

displaying scenarios, 195

display of changes, filtering
in Excel, 304
in Word, 296-298

document formatting, 24

documents. See also Word
closing, 20
creating, 8-10
formatting. See formatting
naming guidelines, 12
opening, 16-17
organizing with outlines, 

104-108
overwriting, avoiding, 14
printing, 19
saving

AutoRecover, 13
as copy, 13-14
as different file type, 15
new documents, 11-12

switching between, 18
uploading into SkyDrive, 

311

doughnut charts in Excel, 173

dragging chart edges in 
Excel, 175

drawing shapes, 47-48

duplicating slides, 207

E
edge of paper, printing to in 

Word, 100

editing
comments

in Excel, 301
in Word, 295

containers in OneNote, 254
custom slide shows, 240

data in Excel cells, 129-130
data tables, 188
links in pages in 

OneNote, 269
scenarios, 194
text in Word, 66

embedded charts, creating in 
Excel, 171

embedding videos in 
slides, 212

emoticons, inserting in Word, 70

endnotes in Word, 108-111

entering
cell addresses in 

formulas, 132
data in cells in Excel, 128
dates/times in Excel, 126-127
fractions in Excel, 160
functions in Excel, 134-137
headings in Word, 73
numbers in Excel, 125
text

in Excel, 125
in OneNote, 253
in Word, 66, 67-68

equation shapes, 46

erasing ink in OneNote, 277

even-page headers, creating in 
Word, 94

Excel. See also worksheets
borders, adding, 166
cells. See cells, in Excel
charts. See charts in Excel
collaboration. See 

collaboration, in Excel
columns, resizing, 164
data

editing in cells, 129-130
entering in cells, 128
types of, 124

data analysis tools. See data 
analysis tools

data formats, 159-161
dates/times, entering, 

126-127
decimal places, controlling 

number of, 163
formulas, 130-133
functions, 133-137
graphics, lassoing, 57
numbers, entering, 125
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ranges. See ranges in Excel
rows, resizing, 165
tables

adding columns/rows, 141
deleting columns/rows, 142
filtering, 144-145
formatting, 139-140
selecting elements in, 139
sorting, 143
terminology, 137-138

terminology, 124
text, entering, 125

Exit command, adding, 7

exiting, 6-7

expanding outline levels in 
Word, 105

exponentiation operator, 131

exporting Ribbon 
customizations, 287

F
fade transition, 227

feet, 28

field names in Excel, 138

fields in Excel, 137

field values in Excel, 138

file naming guidelines, 12

file types, saving documents, 15

files, attaching in OneNote, 
272-273

filling ranges, 150-152

filter list in Excel, 144

filtering
display of changes

in Excel, 304
in Word, 296-298

tables in Excel, 144-145
finding text in Word, 74-75
first-page headers, creating in 

Word, 92
fixed-width typeface, 28
flowcharts, 46
folders, sharing SkyDrive 

folders, 312
font formatting, 23
font schemes, 29

fonts
explained, 27-28
text color, 33-34
type effects, applying, 

31-32
typefaces, 28-29
type size, 30-31

footers, 91
content types in, 91
inserting in Word, 94-95

footnotes in Word, 108-111

Format Painter tool, 42-43

formatting
chart elements in Excel, 179
clearing, 43
copying, 42-43
data in Excel, 159-162
dates/times in Excel, 127
fonts. See fonts
graphics, 60-62
number of decimal places 

in Excel, 163
paragraphs, 35-40
ranges in Excel, 159-167
with Slide Master, 220-223
with styles, 24, 41-42
tables

in Excel, 139-140
in Word, 86-87

themes, 29
types of, 23-24

formatting marks, hiding in 
Word, 118

formulas in Excel, 124
building, 132-133
cell addresses, entering, 132
operator precedence, 133
types of, 130-131

Fraction format in Excel, 160

fractions in Excel, 125, 160

free-form polygons, drawing, 47

fritterware, 66, 226

functions in Excel, 133-134
adding directly to cells, 

134-135
adding with Function 

Wizard, 136-137

Function Wizard, adding 
functions to cells, 136-137

FV( ) function (Excel), 134

G
gallery, adding to Quick Access 

Toolbar, 289

Goal Seek, 189-191

grammar-checking text in 
Word, 79-81

graphics. See also images
formatting, 60-62
lassoing, 57
moving, 59
rotating, 59-60
selecting, 56-57
shapes, 46-48
sizing, 58

green wavy lines in Word, 78

gridlines in Excel charts, 170

groups, adding to Quick 
Access Toolbar, 289

gutter, inserting in Word, 97

H
handwriting text in OneNote, 

274-275

headers in Word, 91-94

heading fonts, 29

headings in Word, 73

hiding
comment indicators in 

Excel, 301
comments in Excel, 302
index formatting marks in 

Word, 118
Ribbon, 284
slides, 216-217

hierarchy category (SmartArt), 52

highlighting text in 
OneNote, 275

horizontally moving 
graphics, 59

hue, 34

hyperlinks in table of contents 
(TOC) in Word, 115
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I
images. See also graphics

as bullets, 36
clip art, 51-52
pictures, 50
SmartArt, 52-54
text boxes, inserting, 55
types of, 49
WordArt, inserting, 55

indentation, applying, 39

indexes, inserting in Word, 
116-120

initials, changing, 281-282

ink in OneNote, 274
converting to digital 

text, 276
erasing, 277
handwriting text, 274-275
highlighting text, 275

ink integration, 274

inserting. See also adding
bibliography/citations in 

Word, 111-113
clip art, 51
comments

in Excel, 301
in Word, 294

date/time in pages in 
OneNote, 267-268

footers in Word, 94-95
footnotes/endnotes in 

Word, 109-111
gutter in Word, 97
headers in Word, 92-94
index in Word, 116-120
lines, 46-47
links in OneNote, 268-270
pages in OneNote, 251-252
pictures, 50
ranges in Excel, 155
rows/columns in tables in 

Word, 88-89
sections in OneNote, 249
shapes, 48
slides, 206
SmartArt, 53-54
spreadsheets in OneNote, 

271-272
symbols in Word, 69-70

table of contents (TOC) in 
Word, 114-116

tables
in OneNote, 255-257
in Word, 84-85

text boxes, 55
WordArt, 55

italic type, applying, 31-32

iterative method in Excel, 190

J–K
keyboard shortcuts

adding
links to websites in 

OneNote, 268, 270
slides, 206

changing bulleted list 
levels in PowerPoint, 210

circles and squares, 48
closing documents, 20
collapsing outline 

levels, 105
copying ranges, 153
creating

chart sheets, 172
to-do lists in 

OneNote, 260
demoting outline 

levels, 107
editing cell data, 129
expanding outline 

levels, 105
filling ranges in Excel, 150
finding text in Word, 74
hiding Ribbon, 284
inserting

date in pages in 
OneNote, 267

footnotes, 109
pages into 

notebooks, 251
sections in 

notebooks, 249
symbols in Word, 69
tabs, 72
time in pages in 

OneNote, 268
lines, 47
Mark Entry command, 117

moving
items up/down in 

outlines, 107
ranges, 154

navigating slides, 243
new document, 9-10
opening

documents, 17
Options dialog box, 280

paragraph alignment, 40
paragraph indentation, 39
pasting ranges, 153
pinning Ribbon, 284
printing documents, 19
promoting outline 

levels, 107
replacing text in Word, 76
Save As command, 11
starting slide shows, 240
switching between 

documents, 18
text effects, 32
tracking changes in 

Word, 296
type size, 30

keyboards, changing onscreen 
keyboard layout, 67

L
landscape orientation, 98

lassoing graphics, 57

layout of charts, changing in 
Excel, 177

layout of slides, changing, 216

leader tabs, 72

left tabs, 72

legends in Excel charts, 170, 182

line charts in Excel, 173

lines, 46-47

links
to OneNote locations, 

inserting, 269-270
to pictures, 50
to websites, inserting in 

OneNote, 268-269

list category (SmartArt), 52

list levels in PowerPoint, 209
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321organizing documents with outlines

lists. See bulleted lists; 
numbered lists; to-do lists

luminance, 34

M
manually recalculating data 

tables, 189

margins, setting in Word, 96-97

Mark Entry command 
(Word), 117

market share for 
PowerPoint, 203

markup, defined, 297

matrix category (SmartArt), 53

merging table cells in Word, 89

Microsoft Office Online, 9

monospace typeface, 28

Most Recently Used list 
(Excel), 136

mouse, selecting text, 25

moving
charts in Excel, 175-176
containers in OneNote, 254
graphics, 59
outline items in Word, 107
pages in OneNote, 251
Quick Access Toolbar, 288
ranges in Excel, 154
sections in OneNote, 250

multiple sides of graphics, 
sizing, 58

multiple versions of slide 
shows, 238-240

N
naming

changing cells (in Scenario 
Manager), 194

documents, guidelines 
for, 12

ranges in Excel, 157-158

narration
clearing, 236, 238
recording in PowerPoint, 

234-238

running slide shows 
without, 237

navigating slides, 241-243

Navigation pane (Word), 73

new documents, saving, 11-12

nodes, 52, 54

Notebook pane, pinning in 
OneNote, 265

notebooks. See also OneNote
closing, 265
creating, 264
defined, 248
pages. See pages in 

OneNote
sections, 249-250
setting properties, 266
switching between, 265
tables, inserting, 255-257
tags, 258-259
to-do lists, creating, 

259-260

notes, adding to slides, 
218-220

numbered lists, creating, 37-38

number filters in Excel, 145

Number format in Excel, 159

number of decimal places, 
controlling in Excel, 163

numbers in Excel, 124-125

numeric formats in Excel, 
159-162

O
object animation (in slides), 

229-232

objective cells (in Solver), 
196-201

odd-page headers, creating in 
Word, 94

Office.com, clip art from, 52

Office RT, customizing
adding commands

to Quick Access Toolbar, 
288-290

to Ribbon, 285-287
bypassing Start screen at 

launch, 282-283

changing user name and 
initials, 281-282

exporting Ribbon 
customizations, 287

hiding Ribbon, 284
moving Quick Access 

Toolbar, 288
opening Options dialog 

box, 280
pinning Ribbon, 283-284
setting background 

pattern, 290

Office RT applications. See 
also names of specific applica-
tions (e.g. Word, Excel, Power-
Point)

documents, creating 
within, 9

pinning
to Start screen, 5
to taskbar, 6

quitting, 6-7
starting, 4-5

one-input data tables, 
creating, 187

OneNote
containers, editing, 254
Notebook pane, 

pinning, 265
notebooks, 264-266
pages. See pages in 

OneNote
sections, 249-250
tables, inserting, 255-257
tags, 257-259
terminology, 248
to-do lists, 257, 259-260

online clip art, searching for, 51

onscreen keyboard, changing 
layout, 67

opening
documents, 16-17
Options dialog box, 280

operators in Excel
arithmetic, 130
comparison, 131
precedence of, 133

Options dialog box, 
opening, 280

organizing documents with 
outlines, 104-108
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Index322 orientation

orientation, changing in 
Word, 98

original graphic, reverting 
to, 62

outlines in Word, 104-108

overwriting
cells in Excel, 153
documents, avoiding, 14

P
page layout, 83

margins, setting in Word, 
96-97

page orientation, changing 
in Word, 98

paper size, changing in 
Word, 99

page numbers in table of 
contents (TOC) in Word, 115

page orientation, changing in 
Word, 98

pages in OneNote
attaching files, 272-273
converting ink to digital 

text, 276
defined, 248
entering text, 253
erasing ink, 277
handwriting text, 274-275
highlighting text, 275
inserting, 251

date/time, 267-268
links to OneNote 

locations, 269-270
links to websites, 268-269
spreadsheets, 271-272
from templates, 252

moving, 251
saving as templates, 253

paper size, changing in 
Word, 99

paragraph formatting, 24
alignment, 40
bulleted lists, 35-36
indentation, 39
numbered lists, 37-38

parentheses in Excel, 125, 133

pausing
Goal Seek, 191
slide timings, 233

Percentage format in 
Excel, 160

percentages in Excel, 125

pictures, 49-50. See also 
graphics

picture styles, 60-62

Picture with Caption 
layout, 205

pie charts in Excel, 173

pinning
Notebook pane in 

OneNote, 265
Office RT applications

to Start screen, 5
to taskbar, 6

Ribbon, 283-284

placeholders in slides, 205

plot area in Excel charts, 170

points, 31

polygons, drawing, 47

portrait orientation, 98

PowerPoint. See also 
presentations; slides

market share, 203
slide layouts, 204-205

PowerPointlessness, 203

precedence of operators in 
Excel, 133

preparing slide shows, 232

presentations. See also 
PowerPoint; slides

animation, 226-232
automatic slide shows, 

244-245
multiple versions of, 

238-240
navigating slides, 241-243
preparing, 232
recording narration, 

235-238
Rehearse Timings feature, 

232-234
running without 

narration, 237

slide layouts, 204-205
sounds for transitions, 229
starting, 240

previewing picture styles, 61

printing
documents, 19
to edge of paper in 

Word, 100

print settings, changing, 20

process category (SmartArt), 52

promoting outline levels in 
Word, 107

proofreading text in Word, 
78-81

properties of notebooks in 
OneNote, 266

pyramid category (SmartArt), 53

Q–R
Quick Access Toolbar

commands, adding to, 
288-290

moving, 288
scenarios, adding to, 195

quick filters in Excel, 145

quitting Office RT applications, 
6-7

radar charts in Excel, 173

range coordinates in Excel, 147

ranges in Excel, 147
copying, 152-153
deleting, 156
filling with values, 150-152
formatting, 159-167
inserting, 155
moving, 154
naming, 157-158
selecting, 148-149

rearranging slides, 215

recalculating data tables 
manually, 189

recording narration in 
PowerPoint, 234-238

records in Excel, 138

red wavy lines in Word, 78
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reference marks in Word, 
108, 111

Rehearse Timings feature in 
PowerPoint, 232-234

rejecting changes
in Excel, 305-306
in Word, 299-300

relationship category 
(SmartArt), 53

removing reviewers in Excel, 
309. See also deleting

renaming sections in OneNote, 
249-250

Replace All command 
(Word), 77

replacing
styles in Word, 77
text in Word, 76-77

resizing
charts in Excel, 176
columns in Excel, 164
containers in OneNote, 254
graphics, 58
rows in Excel, 165

restrictions on shared work-
books in Excel, 308

reusing slides, 208

reverting to original 
graphic, 62

reviewers, viewing/removing 
in Excel, 309

reviewing changes in Word, 
298-299

Ribbon
adding commands to, 

285-287
exporting customizations, 

287
hiding, 284
pinning, 283-284

right tabs, 72

rotating graphics, 59-60

rows
defined in OneNote, 255
in Excel, 124

adding, 141
deleting, 142

resizing, 165
selecting, 139, 149

in Word tables, 84
deleting, 90
inserting, 88-89
selecting, 86

ruler, viewing in Word, 85

running slide shows without 
narration, 237

S
sans serif typeface, 28

saturation, 34

Save As command, 11-12

saving
documents, 11-15
pages as templates in 

OneNote, 253
solutions as scenarios, 201

scatter charts in Excel, 173

Scenario Manager, 192-195

scenarios
adding to Quick Access 

Toolbar, 195
defining, 193-194
displaying, 195
editing, 194
saving solutions as, 201

Scientific format in Excel, 160

scientific notation in Excel, 125

scrolling Start screen, 4

searching for online clip art, 51

Section Header layout, 205

sections in OneNote
color-coding, 250
defined, 248
inserting, 249
moving, 250
renaming, 249-250

selecting
chart elements in Excel, 178
columns in Excel, 149
container text in 

OneNote, 254
graphics, 56-57
ranges in Excel, 148-149
rows in Excel, 149

slides, 215
table elements

in Excel, 139
in Word, 86

text, 25-27

serial numbers, 126

series of values, filling ranges 
with, 151-152

serif typeface, 28

shapes, drawing, 46-48

sharing
addresses with 

SkyDrive, 313
handling conflicts in 

Excel, 310
SkyDrive folders, 312
workbooks in Excel, 

306-308

size of paper, changing in 
Word, 99

size of type, 30-31

sizing. See resizing

SkyDrive collaboration, 
310-313

slide layout, changing, 216

Slide Master, 220-223

slide object animation, 
229-232

slides, 204. See also 
PowerPoint; presentations

advancing automatically, 
244

bulleted lists, adding, 
209-210

changing layout, 216
charts, adding, 212-213
deleting, 218
duplicating, 207
hiding, 216-217
inserting, 206
navigating, 241-243
notes, adding, 218-220
rearranging, 215
recording narration, 

235-236
reusing, 208
selecting, 215
slide layouts, 204-205
Slide Master, 220-223
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tables, adding, 214
text, adding, 208-209
videos

adding, 211
embedding, 212

slide shows. See presentations

slide transitions, setting up, 
227-228

SmartArt, 49
inserting, 53-54
types of, 52-53

solutions, saving as 
scenarios, 201

Solver, 196-201
activating, 197
break-even point, 

computing, 198-200
saving solutions as 

scenarios, 201

sorting tables in Excel, 143

sounds for slide 
transitions, 229

Source Manager (Word), 113

spell-checking text in Word, 
79-81

spreadsheets. See worksheets

squares, drawing, 48

stars, 46

starting
custom slide shows, 241
Office RT applications, 4-5
slide shows, 240

Start screen
bypassing at launch, 

282-283
pinning Office RT 

applications to, 5
scrolling, 4
starting Office RT 

applications from, 4

startup
creating documents at, 8
opening documents at, 16

stopping, 6-7

strikethrough type, applying, 
31-32

styles, 24. See also formatting
applying, 41-42
outline levels, defining, 108
replacing in Word, 77
table styles, changing in 

Word, 87

Styles gallery (Word), viewing 
full list, 42

subbullets, creating, 36

switching between
documents, 18
notebooks in OneNote, 265

symbols, inserting in Word, 
69-70

T
table of contents (TOC), 

inserting in Word, 114-116

tables
adding to slides, 214
columns/rows, adding/

deleting in Excel, 141-142
converting to

in Excel, 138
in Word, 85

deleting elements in 
Word, 90

filtering in Excel, 144-145
formatting

in Excel, 139-140
in Word, 86-87

inserting
in OneNote, 255-257
rows/columns in Word, 

88-89
in Word, 84-85

merging cells in Word, 89
selecting elements

in Excel, 139
in Word, 86

sorting in Excel, 143
structure of, 84
terminology in Excel, 

137-138

tabs in Word, 71-72

tags in OneNote, 257-259

target cells (in Solver), 196-201

taskbar
pinning Office RT 

applications to, 6
starting Office RT 

applications from, 5
switching between 

documents, 18

templates, 8
for charts, creating in 

Excel, 175
creating documents from, 

9-10
inserting pages from in 

OneNote, 252
saving pages as in 

OneNote, 253

text
adding to slides, 208-209
converting

to bulleted list, 35, 210
ink to in OneNote, 276
to numbered list, 37
to table in Word, 85

entering
with AutoCorrect in 

Word, 67-68
in Excel, 125
in OneNote, 253
in Word, 66

in Excel, 124
finding in Word, 74-75
handwriting in OneNote, 

274-275
headings in Word, 73
highlighting in OneNote, 275
proofreading in Word, 

78-81
replacing in Word, 76-77
selecting, 25-27
symbols, inserting in Word, 

69-70
tabs, setting in Word, 71-72
on worksheets, naming 

ranges with, 158
wrapping within cells in 

Excel, 167

text boxes, 49, 55

text color, 33-34

text filters in Excel, 145

themes, 29

tick marks in Excel charts, 170
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time/date
in Excel, 124, 126-127
inserting in pages in 

OneNote, 267-268
updating automatically in 

Word, 93

Title and Content layout, 205

Title Only layout, 205

titles, adding to charts in Excel, 
180-181

Title Slide layout, 205

TOC (table of contents), 
inserting in Word, 114-116

to-do lists in OneNote, 257, 
259-260

tool tabs, customizing, 286

touchscreen, selecting text, 
26-27

tracking changes
in Excel, 303-305
in Word, 296

transitions (for slides), setting 
up, 227-228

Two Content layout, 205

two-input data tables, 
creating, 188-189

type effects, applying, 31-32

typefaces, 28-29

type size, 30-31

U
underline type, applying, 31-32

unhiding slides, 217

unpinning Ribbon, 284

updating
bibliographies in Word, 113
date and time automatically 

in Word, 93
shared workbooks in 

Excel, 308
table of contents (TOC) in 

Word, 116

uploading documents into 
SkyDrive, 311

user name, changing, 281-282

V
value axis in Excel charts, 170, 

180-181

variable cells (in Solver), 
196-201

vertically moving graphics, 59

video embed code, 212

videos in slides, 211-212

viewing
comments in Excel, 302-303
reviewers in Excel, 309
ruler in Word, 85
Styles gallery (Word) full 

list, 42

visualizing data (Excel). 
See charts in Excel

W–Z
wavy lines in Word, 78

websites, inserting links to in 
OneNote, 268-269

weight, 28

what-if analysis, 185-189

Word. See also text
bibliography/citations, 

inserting, 111-113
collaboration. See 

collaboration, in Word
date and time, updating 

automatically, 93
dictionary, adding words 

to, 80
footnotes/endnotes, 

109-111
gutter, inserting, 97
headers/footers, 91-95
index, inserting, 116-120
margins, setting, 96-97
Navigation pane, 73
outlines, 104-108
page orientation, 

changing, 98
paper size, changing, 99
printing to edge of 

paper, 100
ruler, viewing, 85
Source Manager, 113

styles, replacing, 77
Styles gallery, viewing full 

list, 42
table of contents (TOC), 

inserting, 114-116
tables

deleting elements of, 90
formatting, 86-87
inserting, 84-85
inserting rows/columns, 

88-89
merging cells, 89
selecting elements of, 86

WordArt, 49, 55

words, adding to dictionary in 
Word, 80

workbooks, sharing in Excel, 
306-308

worksheets, 123. See also Excel
dates/times, entering, 

126-127
inserting in OneNote, 

271-272
numbers, entering, 125
terminology, 124
text

entering, 125
naming ranges with, 158

wrapping text within cells in 
Excel, 167

XY charts in Excel, 173
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